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Safety Instructions

During each stage of operation of this instrument, please always observe the
following safety instructions. Not taking any safety precautions or following the
instructions will violate the safety standards of design, manufacturing and
application of these instruments. In no case will PROMAX bear the responsibilities
for consequences incurred by violation of the following instructions.

General

This product is a Safety Class 1 instrument. The protective features of this
product may be impaired if it is used in a manner not specified in the operation
instrument.

Environmental conditions

It is designed to operate at a maximum relative humidity of 95% and at altitudes
of up to 2000 meters. Refer to the specifications tables.

Before applying power

Verify that the product is set to match the available line voltage, the correct fuse
is installed, and all safety precautions are taken. Note the instrument’s external
markings described under Symbols.

Do not operate in an explosive atmosphere
Do not operate the instrument in the presence of flammable gases or fumes.

Do not remove the instrument cover

Operating personnel must not remove instrument covers. Component replacement
and internal adjustments must be made only by qualified service personnel.
Instrument that appears damaged or defective should be made inoperative and
secured against unintended operation until they can be repaired by qualified
service personnel.

Electrical safety precautions

If you need to ensure that the equipment completely off, unplug the power line
and remove the battery.

Warning

Only using the AC/DC power adapter in the room.

The equipment should be placed where the surrounding air can flow freely.
Do not operate equipment in the flammable gas or near the smoke.

Do not operate equipment if any part of outer surface (upper cover panel, etc.)
damaged, To avoid the electric shock.

Only approved professional personnel can open and debug and maintenance or
repair the equipment when its power supply is turned on.

Even turn off the power supply, equipment still be in a charged state over a
period of time due to internal capacitor.



* Symbols related with safety:

=== DIRECT CURRENT | ON (Supply)
~_ ALTERNATING CURRENT (_)  OFF (Supply)
[]| DOUBLE INSULATION
~_ DIRECT AND ALTERNATING (Class Il protection)
| A CAUTION

— GROUND TERMINAL (Risk of electric shock)
@ PROTECTIVE CONDUCTOR & CAUTION REFER TO MANUAL
), FRAME TERMINAL = FUSE

o :gf EQUIPMENT OR COMPONENT
%7 EQUIPOTENTIALITY &S TO BE RECYCLED

Descriptive Examples of Over-Voltage Categories
Cat I Low voltage installations isolated from the mains.
Cat 11 Portable domestic installations.
Cat I11Fixed domestic installations.

Cat IV Industrial installations.
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N PROMAX

CABLE AND ANTENNA ANALYSER
AC-726

Scope of this information

Thank you for purchasing Promax instrument. Please read this manual carefully
before using any of Promax instrument. Always observe the warnings and
cautions appearing throughout this manual.

This manual contains the information necessary for proper operation and
maintenance of AC-726 instrument, troubleshooting instructions as well as
information regarding obtaining services.

Unpacking and Inspection

This instrument has been carefully packed in accordance with standard shipping
procedures. Examine the instrument for damage that may have occurred during
shipment. If you find any damage or the instrument is not working, or if any of
the following items are not included, please contact your representative of
Promax.

Product Introduction

AC-726 product is portable, easy to learn and use. Has the characteristics of
powerful function, fast operation, integrated intelligent etc.

AC-726 product is equipped with a large and easy to read color LCD which can
display the measurement data, trace and figure. This product has rich peripheral
interface, users can easily backup or upload data. It is also equipped with a
special PC software with which users can analyze, print, record and archive
measuring data and report with PC management and analysis software. Large
capacity battery, support more than 8 hours of continuous work if charged fully.
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2.1 The head cover

Figure 1.

The head cover contains a variety of interface. A detailed description of the
following.

RF connector: To connect cable and antenna unit to be tested.
RJ45 LAN: Reserved.

Ear socket: Reserved.

USB Device port: To connect PC, then users can run special software to
analyze and manage measurement data.

USB host port: To connect flash disk.
Adapter socket: To connect external AC-DC adapter.
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2.2 Front panel

AN PROMAX

www.promaxelectronics.com

Figure 2.

Screen display area

Indicator LED

Power ON (short press) / OFF (long press)
Keypad

Pen holder

Description for indicator lights:

Position State Meaning
Left Red Battery Charging...
Green Battery Charge fully
Off Power off
Right Green Power on
Red Measuring...

7 April 2016
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Description for hard keyboard:

€3

Adjust the display screen brightness, there are four
levels.

S_w_itch displa_y mode (black and white, normal, night
vision, and high contrast).

Preview, save the measurement picture.
Save calibration and measurement curve.
7 Popup or down the right menu.

:_\ Quick start measurement.

? Backspace.

/; Return to the previous interface.

< Left and right move marker line.
e Up and down move limit line.

(oK) Enter key.
Digital key, input 0-9.

* Decimal point.

# Minus sign.
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3.1 Turn on the instrument

Press O, equipment will display the boot picture. During startup, the right light
turns red, the system will initialize DSP system, self check system state, etc.
When main interface appear, the boot process end, the right light turns green.

A PRONMAX

Test & Vieasurement

www.promaxelectronics.com

05-27-2014 15:00

-JUL

MEASUREMENT CALIBRATION SETTIHGS

Figure 3.: Main interface

.-
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3.2 Main interface

Click “MEASUREMENT” Icon, 5 sub-icons appear, corresponding to the five
measurement modes: DTF (distance fault) return loss, DTF-VSWR, Frequency
return loss, Frequency-VSWR, cable loss. Click the icon, the system will go into
the corresponding measurement interface.

.,[V«.

MEASUREMENT

DTF-Return Loss

05-27-2014 15: 01 -

CALIBRATION

DTF-USWR

SETTINGS

)0 0 CHECYV\S

Freq-USWR

Freq-Return Loss Cable Loss

3 Exit

Figure 4.: Main interface

Click other icons in the main interface (CALIBRATION, SETTINGS, HELP),
system will enter the corresponding operation interface.

April 2016
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Measurement Interface

[Standard Mode]

Idle 05-27-2014 15:47 O 5

Data Points DTF RL

Start Freq.

Stop Freq.

4008 [HHz]

=
=

Start Dist.

[l
=
il

Stop Dist.

o
=

@Cal.0nj

Cal Hode

Paraneter

Display

Data->Hem

3. 261 4§ .4

H
(v
-
(%]
=
ol i

llll[n]

IIL!SHR

w e S'“““t"""”‘" ag?

Single Run

Figure 5.

Measurement interface mainly consists of the following parts:

No. | Name Position Function and Description
1 Status bar | Top Display the_ syste_m status and
measurement information.
. For details, see the later chapter.
Function . )
2 Right Note: If some menu are selected, this
menu )
part may will refresh.
3 Function Bottom For details see later chapter.
menu
Message Frequency, distance, measuring points
4 Left
bar etc.
5 aDrlzzlay Middle For details see later chapter.

11

If the user wants to zoom in the display area, can click the arrow or “Nav”

key. Click again the area will zoom out.
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Detailed description:

Function Function and Description.
Power management mode: standard and power saving
mode.
Measurement state: idle and measuring.
Time: year/month/date/hour/minute.
The adapter and battery state:

1. Connect an external adapter, without battery -
display adapter icon;

2. Connect an external adapter, with battery charging
- display charging icon;

Status bar 3. Connect an external adapter, with battery full -
display adapter icon;

4. Without adapter, only battery - display battery icon,
divided into 5 levels. If battery is low voltage
system will alarm.

Calibration state: (valid)On or (unvalid) off
Note: Only when calibration is valid (on), user can start
measurement.
Marker information.
Limit line information.

Measurement | Measurement points: 137, 275, 551, 1103.

information Start and stop frequency and distance.
Cal mode: enter calibration interface.
Parameter: enter parameter setting menu. If user in the
freg-return loss/ freq-VSWR/cable loss measurement
mode, it will go into frequency parameter setting menu; If
user in the DTF-return loss/DTF-VSWR measurement
mode, it will go into DTF parameters menu, more
parameters and information will be included in this menu.
Display: For details see later chapter.

Function Data-> Mem: Save current data to memory.

menu 1 Note: only one data can be save to the memory.
Auto Run: Start continuous measurement, clicks again to
stop.
Note: While measuring and Auto Run state is on, some
functions are prohibited. If users want to use these
function again, need to click the menu once again and
check the state is off.
Single run: Start single measurement, the system enters
the idle state after measurement.

April 2016
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RL/SWR: fast switching between the return loss and VSWR
measurement.
Marker: For details see later chapter.
i Limit: For details see later chapter.
Function
menu 2 Scale: For details see later chapter.
Smooth/Average: turn on/off Smooth/Average function.
User can utilize these function to observe and analyze
measurement dat.
File: For details see later chapter.
gflraelg display Display the measurement results and other information.
3.4 The function menu description
3.4.1 Marker

In all five measurement mode users can use mark function. The user click
"marker" menu, new mark menu will appear on the right side of screen.

[Standard Mode] 11-13-2814 108:38 -

M1:1.383] M2:2.627 M3 :8.888 M4z 8.8088 M5 :8.888
®Cal.0nje
H1:1.42] H2:68.95 M3 :27 .84 M4 :27 .84 M5 :27 .84

Data Points DTF Return Loss
ﬂ_

Start Freq. W0

20

Stop Freq.
3

4088 [MHz]

Start Dist.

58

Stop Dist.

60

=
4.0 [m] 2.0

I B B
n 4.8
Figure 6.

The system supports 5 marker lines (M1, M2, M3, M4, M5), each marker can be
independent turn on/off and edited. The user can also close all markers.

The user clicks on "MX", the MX marker automatically is activated. The status will
be shown on the top status bar. Users click on the "Edit" menu, the edit menu
will show on the left side of the main display area.

13 April 2016
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[3tandard Hode] 11-13-2814 108:38 -

M1:1.383] M2:2.627 M3:0. 0808 M4: 8. 6008 M5:0.808
M1:1.42] M2 :68.95 M3:27 .84 M4 27 84 M5:27 .84

Data Points DTF Return Loss

[On]/0FF

II

1T

Iy

L1
=
=

; L2 :
: 2.833[m] 7.50[dB]

Start Freq. |Lhdi(REi o, o B R et I W
25 [HHz] [

Stop Freq.

4088 [MHz]

Start Dist.

[0
=
|

Stop Dist.

o
=

Back

S G B

Bl (1o 6.0 n n.0

@ O w orker Ba e % Smoo‘:hfnuerage

Figure 7.: Marker setting menu

[3tandard Hode] 11-13-2814 108:38 -

M1:1.383 M2:2.627 i i2. M4: 8. 6008 M5:0.808
H1:1.42 M2 :68.95 thg . M4 27 84 M5:27 .84

A i3 DTF Return Loss

[On]/0FF

x LI 1 1eu7rn] 6.4xde) | A

M3 - M

Back

Cancel Enter

6.8 n 4.8
@ RL/SWR E} Marker Limit Ba Scale & Smuuthmuerage

Figure 8.: Marker setting menu

The user can define the position of marker line by the following ways:
> The soft keyboard to enter digital value.
The hard keyboard to enter digital value.
Touch screen directly with touch pen to move and define the location.

vwvyy

Left and right arrow key of hard keyboard to fine adjust and define the
location.
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After the location of the mark line is determined, users need to confirm the
operation (soft keyboard "Enter" key or hard keyboard "OK" key).

Users also can click on the "mark to the peak" or "mark to the valley" to
determine the location of the mark line.

For M2~M5, the system also supports difference marker relative to M1. Users
click on the "MX-M1", the system will go into the difference marker mode. The
status displayed in the status bar is the difference between X and Y direction, i.e.
(MX2~5-MX1; MY2~5-MY1).

3.4.2 Limit Line

15

In all five measurement mode users can use limit line function. The user click on
the "limit"menu, the limit menu will appear on the right side of screen. The user
click on the “[On]/off” menu and activate this function. The limit line status
information will display on the top of the screen.

Data Points DTF Return Loss
- . . - - [On]/OFF

Lyl
iy

Start Freq. 18 7
] Single Limit

[*]
=
|

Stop Freq.

ulti-Segment
4888 [HHz]

Start Dist.

[0
=
|

stop Dist. PR

4.8 [n]

BH 2H A ER B

6.8 n 4.8
@ RL/SWR E}Marker Limit Ba Scale & Smooth/Average File

Figure 9.: Limit menu

System supports single section and multi section limit line.

The user clicks on edit box of limit line status(x, y independently), the new edit
menu will pop-up on the left of the screen.
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[3tandard Hode] 11-13-2814 18:31 -

DTF Return Loss
8- - - p - - = - On]/0FF
/M8 i {iMz Ay (on]
: : g : : : : Single Limit

Multi-Segment

T T T T T
6.8 n 4.8
@ RL/SWR m} HMarker Limit Ba Scale % Smooth/Average| File

Figure 10.: Limit setting menu

Cancel

The user can define the limit line position by the following ways
» The soft keyboard to enter digital value
The hard keyboard to enter digital value
Touch screen directly with touch pen to move and define the location

vwyy

Up and down arrow key of hard keyboard to fine adjust and define the
location

After the location of the limit line is determined, users need to confirm the
operation (soft keyboard "Enter" key or hard keyboard "OK" key).

Users can also enable the limit line alarm function. If this function is enabled,
once the measurement data exceeds the limit line, limit line color will turn red
(the default is green).
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3.4.3

Scale

Scale function is mainly used to adjust the Y axis, convenient for users to view

data.

17

[Standard Hode] Idle 11-13-2814 18:32 o 5

T [T T ..,
I 0 2 T s [ e [ I :

DTF Return Loss

Default

Tﬂ M2 Akl

2.055[m] 20.91[dB]

Manual

et
=
==
I ——
——
ey
=~
==
=

Figure 11.: Scale menu

[Standard HMode] Idle 11-13-2014 18:33 1

DTF Return Loss
Default
b H2 A4 Ha

Manual

NY | Aﬂﬂﬂ; ;1]; Top

Bottom

cancel Enter

u-u n l'-u n
@ RL/SWR E}Marker BEI Scale ﬁ Smooth/Average| File

Figure 12.: Manual scale setting menu
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Name

Function and Description

Default

Y axis coordinate go back to the default value.
Return Loss 0~60.

VSWR 1~65.

Cable Loss 0~30.

Auto

Adjust Y axis automatically to adapt current measurement
data.

Manual

Users can edit upper and lower line of Y axis coordinate
manually.

The upper and lower coordinate can only be edited if "manual” menu is
activated.

3.4.4

File

The user can save measurement data or picture to PC; also can recall
measurement data from PC to AC-726. This function facilitate users to
analyze the measurement data later.

Data Points DTF Return Loss

Stop Freq.

4aae

Start Dist.

Stop Dist.

4.8 [m]

&

April 2016

Start Freq. W05

B S B

[3tandard Hode] 11-13-2814 18:33

.-

= - - - - Save Data
1M 1t H2 1"_\th1

Save Pic

[*]
=
|

Recall Data

[HHz]

® Delete

[0
=
|

o
=
L

G Back

a.a m 4.8
RL/SWR w HMarker Limit Ba Scale @ Smooth/Average| File

Figure 13.: File menu
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Local Storage
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Sort By MName | Sort By Time

File Hame

File Hame:

DataFile_DTF_25_4880_551_11132614103404

File Type:lﬂsu Files (*.csu)

|

Figure 14.: Save file interface

ra
-

7]
-

w1
-

=
-

BIF Ertwrs Loy

e e

Figure 15.: Image preview interface
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Import

Local Storage Sort By Hame Sort By Time

File Hame

§

File Hame:

File Type:lﬁsu Files (*.csu)

Figure 16.: File import interface

Delete

Local Storage Sort By Hame Sort By Time

File Hame

§

Select All

File Hame: <7 Delete

File Type:lnll Files (*.%) vl 3 Cancel

Figure 17.: File delete interface
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Name Function and Description
Save Data | The default file type is .csv format.
The default file name includes the measurement mode, frequency,
measuring points, the time information.
users can choose to save in the local memory or external memory
Only support measurement and calibration data.
Save The default file type is the.JPG format.
Picture The default file name includes the measurement mode, frequency,
measuring points, the time information.
users can choose to save in the local memory or external memory
Only support measurement data.
Screenshot only support the curve of measurement data.
Recall The target file can be stored in the local memory or external
Data memory.
Import file must be.csv type and the format must be correct.
Delete Delete the files.
User must return to the superior interface before removing the external
disk.
3.4.5 Display

21

The display menu is mainly used for data analysis. Users can save current data
(either current measurement data or recalled history data) to the memory, then
compare the current measured data and memory data.

Data Points

Ll

Stop Freq.
4000 [MHz]

Start Dist.

Stop Dist.

RLISUR

EINE!NI!NEINII

[Standard Hode] Idle

11-13-2814 18:35

.-

Gal Hode
S e | |

Display

DTF Return Loss

e M M2 A

[X]
=
|

ﬁﬁ Data->Mem

'
- !
(A o pun
Lk AL i, =
w—'l |
Single Run
4.0
w parker & sreethiver age

Figure 18.: Display menu

Ll

=

Lo bl
—
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[3tandard Hode] 11-13-2814 18:35 -

Data Points DTF Return Loss
Only Data

e - m e A
t Frea. B ' .
Start Freq. ] Only Hemory

25 [HHz] [

Data Hemory

Stop Freq.

4880 [HHz]
Data+Hemory

Start Dist.

[0
=
|

Data—Hemory

Stop Dist.

o
=

S G B

4.8 [n]

5~

Figure 19.: Display setting menu

a.8 n 4.

Name Function and Description

Save current data to memory.
Note: Only one data can save.

Data->Mem The data can be the current measurement data, can also be a
historical data. It can recall from local or external disk.
Only Data Display the current measurement data.

Only Memory | Display the memory data.

Display the current measuring data and memory data at the
same time.

32208; Note: the format of two data must be same , such as the
Y mode of measurement, frequency, measuring points, the
distance information etc.
Data + Display “the current measuring data plus the memory data”.
Memor Note: the format of two data must be same , such as the
Y mode of measurement, frequency, measuring points, the
distance information etc.
Data - Display “the current measuring data - the memory data”.
Memory Note: the format of two data must be same , such as the

mode of measurement, frequency, measuring points, the
distance information etc.
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Average/Smooth

Data Points

[3tandard Hode]

DTF Return Loss

11-13-

2014 18:36 o =

HE

i1

M2

Z&Mh1

Smooth[0FF]

Start Freq. 18

]
=

Stop Freq.
4880 [HHz]

Start Dist.

W
=

Stop Dist.

=
=

Average[0ff]

B G ER R

4.8 [m]

a.a m 4.8
@ RL/SWR E} HMarker Limit Ba Scale @ Smoothmuerage

Figure 20.: Average/Smooth menu

Name Function and description.
Smooth For a single curve do smooth operation.
Average | For 2 relative curve do average operation.
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3.5 Calibration interface

The user need to calibrate before the measurement. This instrument use open
short load (OSL) calibration. Users need to follow the instruction and connect
open / short/50 Ohm load respectively to the RF port and do calibration.

[3tandard Hode] 85-29-2814 17:53

Data Points

Parameter

w

(]
=
| I B |

5

'y

Cal.Component

Start Freq. 3“—_

I
=
|

Stop Freq.
Y — et — T :

4000 [HHz] FE z z z

® calon ]

® open SO0 —Vb0 - Loz
® Short

® Load 25 HHz 5000

File

Figure 21.: Calibration interface

The calibration interface is similar to measurement interface. On the left-top of
screen including frequency information, On the left-bottom of screen including
calibration information.

The user can save current calibration data to the local or external disk, or Import
history calibration data to AC-726.

Before calibration, the user need to set the correct parameters, Mainly refer to
the frequency and measurement points. The completion calibration, the
corresponding curve will display on the screen. If calibration is valid, the status
on the left-bottom will become “cal On”. If calibration is invalid or unfinished, the
status will be “cal off”.

After the calibration, the user can return directly to the measurement interface
for measurement.

System support different calibration kit only if user know the exact electrical
length of open/short load. Users can input this parameters in the e parameter
menu.

April 2016
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Is the electrical
length of open
and short cal kit

Is the exact
electrical length of
open and short cal

Return
Loss/VSWR/cable
Loss measurement

Phase/Impedenc-e
measurement

same? kit known?
yes unknown support do not support
yes know support support

know support support

The return loss of 50 ohms cal kit need to be > 42.
The VSWR of open/short cal kit need to be >100.

If the user does not focus on phase and impedance characteristics, cal kit from
other manufacturers can be directly used (usually short and open cal kit have
same electrical length).

Calibration Parameter

Frequency Para
Signal Standard:
Start Freq:

Stop Freq:

Data Points

© 137 0 275
@ 551 1183
-hal kit type Electrical Length @ 1GHz
@ Default
) Standard

) User Define

Electrical Length B 1GHz

Open Phase:

Figure 22.: Calibration setting menu

The electric length is measured at 1GHz frequency, the unit is degree.
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3.6 System Settings Interface

In the system settings interface, users can do all kinds of system configuration.

System Settings

Language

Clock

Display Hode Language
© English
Fan HMode
Espafiol
Power Mode
File Hanagement
Touch Screen Cal
Default

m Return

Figure 23.: Language setting interface

System Settings

Language

Clock

Date Time
Back Light

Year Honth Day

Display Mode

Fan Hode

IIIIHHHHHIHHHHIII

File Management

Hour Hinute Second

Touch Screen Cal

Default

Figure 24.: Clock setting interface
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System Settings

Language

Back Light
Display Hode Back Light
Fan Hode Min Max
File Management
Touch Screen Cal

Default

-
(=]
[
=]
= [x]
a =
=3
L]

ﬂj Retur

Figure 25.: Back light setting interface

System Settings

Clock

Back .,
Display Hode

Display Hode @ Default Colors

Black-White
Fan Mode

|||||‘|||\||!||

High Contrast
Po

=
(-]
=
]

Night Vision

File Management

Touch Screen Cal

Default

ﬂj Retur

w
=2
'=}
=
[
[r=
L]

Figure 26.: Display mode setting interface
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System Settings

Language

-~
-]
[x]
=
("
a

Clock
L
Fan Mode
Display Hode
@ Auto
Fan Hode " Always oOn
Power Hode Always Off

File Management

Touch Screen Cal

Default

ﬂj Retur

Figure 27.: Fan mode setting interface

System Settings

Language

Clock

-
-]
[zl
=
I

Display HMode Power Hode

@ Standard
Fan Mode

Power Saving
Power Hode

Touch Screen Cal

Default

ﬂj Retur

Figure 28.: Power mode setting interface

April 2016
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System Settings

File Manager

Language . . =
Data Files I Cal Files l Image Files

Clock

Back Light

Display Mode

Select All Delete Selected
External Storage

Fan Hode

Power HMode

File Management

Touch Screen Cal

Default select All Delete Selected

Figure 29.: File manager interface

1. Please make sure that the external memory has been inserted before
operating “File Management”;
2. User must return to the superior interface before removing the external

disk to make sure files performed.

System Settings

File Manager
Data Files | Cal Files I Image Files

Language

Clock

Back Light

Display Mode
Load Default Parameters?

Fan Hode
External

Power Mode

File Management

Touch Screen Cal

Default

Select All Delete Selected

=
m
-
€
E

Figure 30.: Load default setting interface
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Name Function and Description
Language Support English / Spanish
Clock Year, month, date, hour, minute and second.
Back Light Support 4 levels brightness adjustment.
4 modes:
Default:
Display Mode Black-white: used for printing
High-contrast:
Night vision: used in night environment
Three modes: Auto; Always On; Always Off.
Fan Mode The default is Auto mode. If temperature higher than 45

degrees, fan is turned on; if below 35 degrees fan is
turned off.

Power Mode

Two modes: standard modes (default); power saving
mode.

If working in the power saving mode, the relative RF
circuits will be power on until measurement. It can save
power’s consumption and protect circuits, but its
disadvantage is the measurement time will be a little long.

File management

For file management of both local disk and the external
disk.

Support file copy and delete functions.

Support following file type: measurement data(.csv),
measurement image (.Jpg), calibration data (.csv).

Touch screen Cal

To calibrate the touch screen. Users Can exit by pushing
any hard key.

Default

Restore to default value.

April 2016
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Help Interface

(=) version Info

Uersion Info

‘@_ Pevice Info Hardware Uersion:  400.400.300

(@] visk 1afo Software Uersion: 132.100.100

';_j Battery Info

' Serial Humber: l

:@, Update Firmware

Figure 31.: Version information interface

= ey
[-._.J Uersion Info
Device Status Info

— Temperature: p°c
| pevice Info

Battery Uoltage: = -----

r 5
(&) pisk 1nfo RF Subsystem Status: Failed : 101,102

DSP Subsystem Status: Passed
a Battery Info

Main Control Unit Status: Passed

@ Update Firmware

Figure 32.: Device information interface
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E[.:-J‘ Uersion Info
Disk Info

Size Used Available Used
4] pevice Info
Local Disk: 512H 200M 312M 392
[S‘ Disk Info
a Battery Info SD Card: 1.86 ] 1.86 0%

\-g, Update Firmware

Figure 33.: Disk information interface

(=) yersion Info Battery Information

Battery Status: Fully charged
] pevice Info
= Battery Uoltage: 12.6 V

Full Charge Capacity: 7.50 Wh

[§) pisk Info

Remaining Percentage: 100 %
m Battery Info Remaining Time: 08:00 h

Remaining Capacity:

(% Update Firmware

Figure 34.: Battery information interface
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Firmware Update

External Storage Sort By Hame Sort By Time

File Name

§

& Ok

Figure 35: Firmware update interface

On the help menu, the user can view a variety of instruments information;
meanwhile users can upgrade the firmware.

Name Function and Description

Incluyes hardware version software version instrument

Version Info .
serial number, etc.

Includes: board temperature, battery voltage and

Device Info instrument subsystems statue, etc.
Includes: the information of local disk and a built-in SD
. card.
Disk Info

Note: the local disk refer to flash memory, the different
version of the program will have different residual space.

Showing the working status and residual power of the

Battery Info battery and other information.

The user insert the U-disk to the instrument, select the
correct version file; the instrument will automatically
Update Firmware upgrade.

After the upgrade is complete, the instrument
automatically restarts.
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4.1 Set frequency parameter

The user needs to properly set the frequency parameter before testing. In the
following ways users can enter the frequency setting interface.

Calibration Parameter

requency Para
Signal Standard:
Start Freq:

Stop Freq:

Data Points

o137 o) 275
@ 551 1 1103
= -
Cal kit type Electrical Length @ 1GHz
@ Default
Open Phase:
) Standard

Short Phase:

' User Define

Figure 36: Calibration setting interface
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DTF Parameter

Start Dist:

Stop Dist: m Dmax: 28.7 m

Start Freq: MHz Min/AF :55 HHz

Stop Freq: HHz AD: 6.83 m

Cable Type:

Prop Vel:

Cable Loss: g.868
Data Points Window Function Units
137 @ Rectangular @ HMetric
o1 275 ") Hamming 1 Inch
@ 551 ) Kaiser
1183 1 Blackman

Figure 37: DTF setting interface

Freq Parameter

Stop Freq:

Data Points

o137 ) 275

@ 551

Figure 38: Frequency setting interface
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» In the "calibration" interface, click on the "parameter" button

» In the "frequency return loss" or "frequency VSWR" or "cable loss
"measurement interface, click on the "parameter"” button

» The user can also input frequency parameters in "DTF parameter setting"
interface

After entering frequency setting interface, the user can set start frequency and
stop frequency through the following ways

» Select pre-defined Signal standard
» Manual input frequency parameter

Users can click on edit box to edit the parameter of frequency, system will pop up
the soft keyboard. The user also can directly press the digital keys of hard
keyboard.

The users need to select measurement points. System supports 4 options: 137,
275, 551, 1103.

If the measurement point is set to 1103, compared with the set to 551, it will
take about 2 times longer measurement time. And so on.

The minimum frequency interval is 1 MHz.

The start frequency range is 25~3999 MHz; The stop frequency range is
26~4000 MHz.

The user can modify the pre-defined signal standard through PC software.

4.2 Set DTF parameter

The user needs to properly set the DTF parameter before DTF testing. In the
following ways users can enter the DTF setting interface.

Enter the "DTF-return loss" or "DTF-VSWR" measurement interface, select
"parameter" menu.

April 2016
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DTF Parameter

Start Dist:

Stop Dist: Dmax: 28.7 m

Start Freq: MinAF :55 HHz
Stop Freq: Ab: 8.83 m
Cable Type:
Prop Uel:

Cable Loss:

cable Cal

Data Points Window Function Units
137 @ Rectangle @ Metric
275 Hamming Inch

@ 551 Kaiser

1183 Blackman

Figure 39 DTF setting interface

The user can complete the following functions at the DTF parameter setting
interface.

» Enter frequency information and measure points.
Enter the distance information.

Enter the cable parameters.

Select the window function.

vvyywyy

Set unit (support metric and Imperial).

The user can modify the pre-defined cable parameters through PC software.

4.2.1 Set Distance parameter

Distance parameters need to satisfy the testing needs, but also associated with
the following parameters

» The operating frequency range (F1, F2).
» The number of measured points (N).
» Cable propagation velocity (Vp).

Once the user set the operating frequency, the number of measured points, cable
propagation velocity, the maximum allowed cable length (Dmax) has be decided.

1

Dmax = N *150*10/8*Vp * ————
F2-F1
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For the convenience of users, the system will automatically display the relevant
information (the maximum allowed cable length: Dmax; resolution A D) in the
upper right corner.

For example: N = 551; Vp = 0.85; F1 = 25 MHz, F2 = 4000 MHz. The
corresponding Dmax is 17.64 meters, A D is 0.03 meters;

Do not change the frequency, if users want to increase the allowed cable length,
can increase the number of measuring points, the corresponding test time can
also be longer.

Due to the calculation of DTF, the minimum frequency interval is (N-1)
*100 kHz. If the measurement points is 551, corresponding minimum
frequency interval is 55 MHz.

The minimum distance interval is 1 meters (inch) or 1 feet (inch).

Start distance range is: 0~Max-1; stop distance range is 1~Dmax.

4.2.

April

2 Set Cable parameter

Users can manually input cable parameters (velocity; cable loss) or select the
type of cable known.

The propagation velocity of electromagnetic wave in the cable is less than the
vacuum speed (300M meters /second). Propagation constant is 0.85, meaning
that the actual propagation velocity of the electromagnetic wave in the cable is
the 0.85*300M meters / second.

When the user in the fault distance analysis, often want to know the return loss
or VSWR of one exact connector. At that position, the cable loss and connector
return loss will be mixed together, systems need to remove cable loss impact in
the calculation connector return loss. The unit of cable loss is dB/ meter.

Users can select cable from pre-defined cable list. Usually the cable loss will vary
with frequency .System will automatically calculate the cable parameters
According to the cable parameters and working frequency.

If the user does not know any cable information and parameters, but have a
cable at hand, users can use the system tools ("cable" cal) to get these
parameters.

Click on the "cable cal" button in the DTF parameter interface, system will pop up
one window. Users enter the measured actual length of cable (0.5~10 m); one
end of the cable is connected to the RF port, the other end connected to open
load or connected to nothing. Once the calibration is completed, the cable
parameters will automatically refresh in DTF parameter interface.

2016
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Cable Calibration
Cable Length:m

please connect a open load to calibrate

Figure4O.

Set Window Function

In the distance to the fault analysis, if the location of the two connectors are
close, because of the influence of spectral leakage, two connectors will be
influenced each other. If return loss of one connector is much smaller than
another one, most probably it will be lost and can’t be recognized. In this case
users should choose to use the window function.

System support four types window function: rectangle window, Hamming
window, Keyser window, Blackman window.

4.3

OSL Calibratrion

The user needs to confirm the system is in "calibration valid" state before a test.

Before one test, system need to know beforehand the 3 known load (open
/short/500hm) test results. The user can import the previous calibration data; or
do OSL calibration before test.

The user can enter the calibration interface by the following ways.

» In the main interface, click on "calibration" mode icon.
» In the measurement of interface, click on the button "cal mode".

The OSL calibration procedure is as follows.

39

» Set the frequency parameter.
» Set up calibration parameters (optional).
» Calibrate the first load.
Connect the load to the RF ports, click on the corresponding button.
The system will pop up a small window, click on the “"OK".
System start calibration.
Once calibration is completed the screen will display the curve.
» Calibrate other loads.

» If all calibration of three loads completed, the green "cal on" will shown at
the lower left corner of the screen.

April 2016



/a\ PROMAX

Users can directly calibrate at the RF port, also can calibrate with a high
performance cable connected to RF port. If the former, usually, the calibration
curve of 50 ohm load will be significantly lower than the other two.

If calibration is completed, the user can start measurement.

The user can also select the file menu to save the calibration data in the local or
external disk.

After the system boot, the default calibration data will be recent one.

The user clicks on the "file" menu, click "import", can recall previous calibration
data. If the environment is similar, the previous calibration data can be used
directly.

Need to re calibration if frequency changed or measurement points increased
Need to re calibration if temperature changes a lot

Do not need re calibration if measuring points reduced.

Do not need re calibration if distance, cable parameters, window function
changed.

4.4

Freq-Return Loss, Freq-VSWR, Cable-Loss measurement

The measurement can be used to verify the power matching of the port or the
loss of the cable .X axis coordinate is frequency, Y axis coordinate are VSWR, or
the return loss, or loss of cable separately.

In the following ways users can enter the measurement interface.

In the main interface, click on the "measurement" icon, and then click the
corresponding icon.

In the measurement interface, the user can do a variety of measuring operation.

Need to set proper frequency parameters before test
Need to confirm that the system is in "calibration valid" state before test
The minimum frequency interval is 1MHz

April
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DTF-VSWR, DTF-Return Loss measurement

The measurement can be used to verify the power matching performance of
different position of cable and antenna system, then user know a certain position
joint connection quality. X axis coordinate is distance, Y axis coordinate is VSWR,
or return loss.

In the following ways users can enter the measurement interface.

In the main interface, click on the "measurement" icon, and then click the
corresponding icon.

At the measurement interface, the user can do a variety of measuring operation.

Need to set proper frequency, distance, cable parameters and window
function before test.
Need to confirm that the system is in "calibration valid" state before test.

41

The maximum measuring range and accuracy associated with frequency
parameters, the propagation velocity of cable.

The minimum frequency interval :(N-1) *100 kHz (N: measurement points).

The user can set the unit in the DTF parameters window units (metric and
Imperial).
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Specification

Frequency Range 25-4000 MHz

Frequency 100 kHz
Resolution

Frequency )
Accuracy +/-25 ppm

Output signal level | 0 dbm (typical)

Measurement

speed 3.5 ms / point

Measurement point | 137, 251, 551, 1103

Directivity 42 dB (after calibration)
On-channel 17 dBm > 1 MHz away from carrier

Interference freq.

Immunity On-frequency -5 dBm, within +/-10 kHz of the
carrier freq.

Freg-RL range 0~60 dB

Freg-RL Resolution | 0.01 dB

Freg-VSWR range 1~65

Freq-VSWR 0.01
resolution

Cable Loss range 0~30 dB
Cable L_oss 0.01 dB
Resolution

DTF- return loss 0~60 dB

range

DTF-VSWR range 1~65 dB

Distance-to-Fault
range

1500 meters

1.5%1078*Vp / (F2-F1)
Vp: velocity propagation constant;
F1, F2: start and stop frequency

Distance-to-Fault
Resolution
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General Information

RF Connector

Type N, female

Input impedance 50 Ohm

Display 7 inch resistor touch LCD, 800*480 resolution
1 USB Host

Data interface 1 USB Device

1 10M/100M adaptive LAN

Storage >2000 curve
Language Spanish, English
Battery Type: Li-Ion

11.1V 7800 mA

External Adaptor

110~240 50~60 Hz AC input, 16 V 3.75 A DC
output

Working 10 OC ~ 50 0C
temperature
Storage temperature | -40 9c ~ 70 ©Oc

Humid

0~85% (no condensation)

Weight

2.5 kg (net weight)

Size

290%x175%x75 mm

*Specifications subject to change without notice.
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PROMAX ELECTRONICA, S. L.

Francesc Moragas, 71-75

08907 L'HOSPITALET DE LLOBREGAT (Barcelona)
SPAIN

Tel.: 93184 77 00 * Tel. Intl. : (+34) 93 184 77 02
Fax : 93 338 11 26 * Fax Intl. : (+34) 93 338 11 26
http://www.promaxelectronics.com

e-mail: promax @ promaxelectronics.com
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